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Introduction to Captivate Quizzes

Overview

Macromedia Captivate is a software application for creating interactive
demonstrations and simulations. It is especially useful for creating software
simulations and online tutorials. It also enables a designer to add and customize
a variety of interactive question slides, which can be combined to create
assessment instruments.

If you have created or are creating a Captivate movie for e-learning, there are
several reasons for using Captivate to create your learning assessment.
1. Immediate assessment
The learner will not have to navigate to another file or application to
complete the assessment.
2. Integration with LMS
If you are using an LMS, Captivate has built-in capabilities for sending the
results of the assessment to the LMS. Even if you aren’t using an LMS,
Captivate can email the results to a specified address.
3. Authoring in a single application
It’s easier to maintain the look and feel of your e-learning when everything
1s authored using the same application.

Course Objective

Given a Captivate movie, the learner will add at least two assessment items and
configure them accordingly.

Instructional Objectives

e Given a Captivate movie, the learner will be able to open the Quiz
Manager and configure the Reporting, Quiz, and additional options

e Given a Captivate movie, the learner will be able to insert a new Question
Slide.

e Given a Captivate movie, the learner will be able to insert and configure a
multiple choice question.

Getting Started

Requirements

The entire lesson should take you less than two hours to complete. To complete
the lesson, you will need access to a computer with Captivate. If you don’t have
Captivate, you can download a trial version at
http://www.macromedia.com/cfusion/tdrc/index.cfm?product=captivate



It’s best to print a copy of the lesson so that you can refer to it while you work on
a Captivate movie, but you can open the electronic version of the lesson in
Microsoft Word if you prefer.

You will need...
» Two hours total
» Computer with Captivate

System requirements:

Microsoft Windows 2000 or Windows XP

A 600-MHz Intel Pentium III processor or equivalent

128 MB of RAM (256 MB recommended)

100 MB of available disk space

800 x 600 resolution color display or better (1024 x 768, millions of colors
recommended)
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Software and accessories for publishing and recording:
» Internet Explorer 5.0 or later
» Flash Player 6 or later
» Microphone to record audio
» Speakers and sound card

How to Complete this Lesson

This lesson 1s divided into three modules which should be completed in sequence
because each module builds upon the knowledge and skills gained in the previous
module. Following is a brief overview of each module:

1. Using the Quiz Manager (45 min.)
This module provides a introduction to Captivate’s Quiz Manager. You will
learn how to configure the parameters of your assessment instrument,
including the output options (e.g. to your LMS), navigation and branching,
default feedback messages, and the percentage/score needed to pass.

2. Inserting a Question Slide (20 min.)
This module teaches you how to insert a Question Slide into your
Captivate movie. You will learn about the types of questions available as
well as strategies for using them.

3. Configuring a Multiple Choice Question Slide (30 min.)
This module teaches you how to configure a particular type of Question
Slide: Multiple Choice. Once you know how to configure one type of
Question Slide, the others are easy. You'll learn how to configure a single
slide’s parameters, including feedback messages, branching for correct and
Incorrect answers, and weighting questions.



Adding a Quiz to a Captivate Movie

Once you have everything you need, continue to Module 1: Using the Quiz
Manager.
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Adding a Quiz to a Captivate Movie

Using the Quiz Manager

Module 1 goes here.
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Adding a Quiz to a Captivate Movie

Inserting a Question Slide

Module 2 goes here.
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Adding a Quiz to a Captivate Movie

Overview of Module 3

In Module 2 you learned about the types of Question Slides available in
Captivate as well as strategies for using those slides.

In this module you will learn how to configure the Multiple Choice Question
Slide. Once you understand how to configure one type of Question Slide, the
others are fairly easy. You will learn how to enter a question and multiple
answers (specifying one or more answers as correct), configure the messages and
branching for correct and incorrect answers, enter metadata for the LMS, and
weight a question.

Getting Started

In Module 1 you opened a Captivate movie and configured the quiz parameters
using the Quiz Manager. In Module 2 you learned how to insert a Question Slide.
Now open the Captivate movie (if it’s not already open).

Inserting a Multiple Choice Question Slide
Just as you did in Module 2, you’ll begin by inserting a Question Slide.

Select the slide before where you want to insert a Question Slide. In this case
you're going to insert the slide at the end of the movie, so select the last slide.

H [ @ Macromedia Captivate - [01_open_template_small_cp]
Select Insert > Question L e
i e & FTetcapton.  SheCURC |y L
Sllde. HS“ [ Highlight Box... Shift+CrrsL ) A | (o8] Qm
Swntewd (Bt IR image... Shft+CirieM
= T} Rolover Caption...  Sht=Ctri=R
Shide Tash &y polover Image...  ShIt+CUtD
B o T Clck Box... Shift+Ctri«K
") Mouse [T Text Entry Box..  Shit+CrisT
Gy video Quatty | BUTON... Shit+Ctri+8
1) mecord adang I Animation. . Shift+Ctri+A
cooyside | TEXtANMation..  Shit+CirleX |,
Image Side...
*® Blank Skie I
—] ride Side PowerPont Side...
[ Progertes Animation Side...
= Informati &) Record Addiional Sides...

Size: 1503968 (0. 1K)
Time: 01:14 (2245) |
Auden ook
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Adding a Quiz to a Captivate Movie

Question Types

The Question Types dialog box shows Question Types X
the various types of questions available, Question Types —
along with brief explanations of each Choose a question type from the list below. _f/’EJ
type.

Multiple choice

The multiple choice question gives the user the option to

Select Multlple choice and click OK. choose one or more correct answers from a list of possible

answers.

True/False
The truefalse question gives the user the option to choose
from two possible answers,

Fillin the blank
) . ) A A fill-in-the-blank question gives the user a list of possible
Conﬁgu Il ng a MUIU ple Ch0|Ce choices to pick from in order to fill in the blank space in the
_ . guestion,
Question Slide > Short answer

A short answer guestion,

Matching

i A matching guestion gives the user a list of items that must
Th e Qu eStI on Tab be matched to another list of possible answers,
Enter a Title for the question. The title Liert

. . . 5 Like
appears on the S].lde mn the movie. It,S a A& Likert question gives the user a list of items to categorize
. . . . from a scale,

good idea to give each question a unique
title.

I oK H Cancel ” Help

In the Question text box, type you
question exactly as you want it to afipear on the slide.

In the Answers area, click ——— R
Question |D jons | Reporting |

the Add button to enter the
possible answers. You can
use the Delete button to Title: uitple choice
remove answers, and you Queston: [ type the question here ¥
can order the answers

using the Move Up and
Move Down buttons. .

Question

Use the Style pulldown to Ansiiers

. Select correct answers here
specify whether the hd
q]iesti};n has a single ¥ A type the answer here —

correct answer or multiple

correct answers.

Use the Numbering B

pulldown to specify the
1 le fi h Style:  |Single answer + | Mumbering: |A,B,C... v

numbering style for the g | | g

answers.
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Adding a Quiz to a Captivate Movie

If you selected the “Single answer” style, each answer has a radio button next to
it. Click the radio button next to the correct answer. If you selected the “Multiple
answers” style, each answer has a check box next to it. Click the check boxes next
to each correct answer.

The Options Tab

Select the Options tab [ Question | Optons |Reportng
Type
Use the T o ulldOWn to Type: |Graded - there are right and wrong answers hd |
if }iq?chp th o
specl y W' ether e X If correct answer
question is graded or is a Jump to: eotorextsice &3

survey. You are creating a
quiz, so select “Graded.”
Show correct message

In the If correct answer

If wrong answer

area you ?,peCIfy what Allow user: I:l % attemptsor || Infinite attempts
happens if the learner
chooses the correct answer Jump to: |Go to next siide v

to the question.

W | Show error message | Show incomplete message
The Jump to pulldown
offers a variety of options Buttons
for COl’ltI‘OHing the path [+] Show clear button [+] Show back button [+] Show next button

that the learner takes.
This is known as
“branching,” which means that the learner’s path is determined by choices made
by the learner. For example, a correct answer may allow the learner to continue
to the next content item, while an incorrect answer may send the learner to a
slide for review.

The Jump to pulldown offers the following

Go to previous slide

OptiOl’lS: P> |Go to next side
Jump to slide

Open URL or file

Open other movie

e (Continue: Select this option to have the Send e-mail to
movie continue playing. Prece S aet

e (o to previous slide: Select this option to have the movie return to the
previous slide.

e (o to next slide: Select this option to have the movie proceed to the next
slide

e Jump to slide: Select this option to have the movie jump to a specific slide.

e Open URL or file: Select this option to have the movie jump to a specific
URL on the Internet or to a local file. Click the pop-up menu to select the

Rod Myers Page 9 of 12



window in which the URL should appear; choose from Current, New,
Parent, and Top.

e Open other movie: Select this option to have the movie begin playing a
different movie. Click the pop-up menu to select the window in which the
movie should appear; choose from Current, New, Parent, and Top.

e Send e-mail to: Select this option to open the default mail browser.

e [xecute JavaScript: Select this option to run a specific piece of JavaScript
code.

0 Click More to enter the JavaScript you would like to execute.

e No Action: Select this option to have messages (e.g. error or retry) appear,

but no other action take place.

j Options i
The Show correct message S VWS e

check box determines e
Whether the learner sees the Type: Graded - there are right and wrong answers w
default feedback message (as . _
e . . If correct answer
specified in the Quiz o v

Manager—see Module 1).

In the If wrong answer area [v/] show correct message

you specify what happens if
the learner chooses the Alow user: 1 |* asttemptsor [ ]Infnite sttempte

incorrect answer to the
question. Jump to: Go to next slide w

The Allow user fields specify

If Wrong answer

v | Show error message | Show incomplete message
the number of attempts the
learner can try before Buttons
another action (SuCh as a [#] Show clear button ] Show back button ] Show next button

Jump to action) occurs.

The Jump to pulldown offers the same options as the one in the If correct answer
area. Use the Show error message check box to specify whether the learner sees
the default feedback message for an incorrect answer. If you've allowed the
learner more than one attempt, use the Show retry message to provide a message
like “Please try again.” Use the Show incomplete message to alert the learner if
she fails to select an answer (e.g. “Please select an answer.”). The default text for
these messages is specified in the Quiz Manage (see Module 1).

The Buttons area allows you to specify whether the learner sees various buttons
that facilitate navigation through the movie.



Adding a Quiz to a Captivate Movie

The Reporting Tab
Select the Reporting tab.

Use the Report answers Question || Options | Reporting |

check box to specify
whether this question is
part of the overall quiz
score. Contact your LMS

Report answers
f Objective ID: | Quiz10022 |

Interaction ID: |Interach'on 11302 |

administrator for the Settings
appropriate values to use Weighting: -
fOI' Objective ID and Time limit: I:I

Interaction ID.

The Objective 1D 1s
optional. If the question is
related to an objective set
in the LMS, enter the LMS
objective ID in this field.

Enter an Interaction 1D if
you want Captivate to send
tracking information to the

LMS.

In the Settings area, enter a value for the weight of the question using the
Weighting scrolling list. As you might expect, a question with a weight of 2 is
worth twice as much as a question with a weight of 1.

. . | @ Macromedia Captivate - [01_open_template_small.cp - Slide 17 of 17°] 8 [z
If you want to limit the e Edt Vew et Sde Awo Move Optors Heb X
. Save & Undo 4 Becord | T J Prevew w [ Publsh | [Sa] P oo [
amount of time the learner | =777 ©= ——%=08
has to answer the LS — [ -
question, click the Time i : Multiple choice | corest- Cick
limit check box and enter |08 | | typethe question here R
the amount of time in fim—= § || * A typetheanswer here to continue
vt . ] B) type the answer here Ple. et |
hours:minutes:seconds a:iﬁf:sje,
format (e.g. 00:02:30 is 2 Porsih
minutes and 30 seconds). 50 |
When you’re finished | 5
configuring the Multiple — Ao
Choice question, click OK. = e
The new slide should Question 1 of 1 Clear Back Next Submit
e i

COBSBMBIMODT I
& Movie path: C:\temp\Rod\sjsu\EDIT_2B5\Courssiet_Learning_Objects\movies\D1_open_template_smal.cp B99xE52
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appear at the end of the Captivate movie.

Review of Module 3

In Module 1 you learned how to configure a quiz using the Quiz Manager. In
Module 2 you learned how to insert a Question Slide. You also learned the
similarities and differences among the various types of Question Slides, and you
examined some strategies for combining and sequencing slides to create a quiz.

In this module you learned how to configure the Multiple Choice Question Slide.
In particular you learned how to:
e enter a question and multiple answers (specifying one or more answers as
correct)
e configure the messages and branching for correct and incorrect answers
e enter metadata for the LMS
e weight a question and set a time limit

By now you should see how powerful Captivate is and have some ideas about how
you can use it in your teaching and instructional design. You should be able to
apply what you learned about the Multiple Choice Question Slide to configure
other types of slides. Remember to use Captivate’s Help features if you run into
something you can’t figure out.



